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Introduction 

We are a team of interdisciplinary 3D developers with a focus 
on inclusive learning using XR technology in education.Our 
backgrounds range from interior design, architecture, and 
digital media, and we have combined our skills to create a 
guide to 3D development focused on VR interactives that 
range from beginner to advanced 3D development. With this 
toolkit we hope to cover any essential features like 3D 
modelling software (Blender), and two interactive 3D 
applications using Unity and Unreal Engine to engage with 
Toronto Metropolitan University’s Library Immersion Studio. 

 
Michael Carter-Arlt is the Immersive Technology Specialist at 

the Toronto Metropolitan University (TMU) Library. In this role 
he utilizes his skills in Graphic Design, 2D Animation, Digital 
Media, and 3D Development to create XR (Extended Reality) 
projects related to pedagogy, SRC (Scholarly, Research and 
Creative)projects, as well as the creation of OER (Open 
Educational Resources). Michael also manages the Immersion 
Studio in the TMU Library, which is a 360° interactive projection 
cylinder designed for collaborative Virtual Reality experiences. 
He has worked on multiple projects related to XR in education, 
and has worked on projects for the Aga Khan Museum, the 
German Consulate of Toronto, and the USC Shoah Foundation. 

 
Ava, as an architect with a master’s and bachelor’s degree 

in Architectural Technology and Architecture and a master’s 
degree in Digital Media, I provide innovative design solutions 
for a variety of applications. My experience covers cutting-edge 
technologies, such as Virtual Reality and Computational 
Design, with a focus on sustainability. I specialize in creating 
dynamic, user-friendly, and productive design solutions while 
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managing projects from initial concept through entire life-
cycle implementation. She has an eye for leading-edge design 
and strive to create buildings and spaces that are aesthetically 
and ecologically pleasing while maintaining their timeliness 
and relevance. 

 
Michelle, an interior design student skilled in design, 

photography and production of various collaborative projects, 
with a passion and a creative curiosity in all things design. Her 
creative interests are guided by multidisciplinary design and 
learning about new design and how design disciplines can 
be interconnected. She has worked on numerous collaborative 
design competitions, community design projects, and 
entrepreneurial spaces, including designing an MVP and 
developing marketing products for online engagement. In her 
recent role as a Research Assistant with PARA Lab, she has 
collaborated on a community design project (Planting 
Imagination) where she co-designed a community garden and 
led the digital design platform development. 
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3D DEVELOPMENT 

Overview 

What is 3D Modelling 

3D modelling is a computer-generated process that allows 
creatives like you to create three-dimensional objects and 
scenes that can be manipulated in a virtual space. It is a 
powerful tool that enables creative professionals to bring their 
ideas to life, and it has become an essential part of industries 
such as gaming, film, architecture, animation, product design, 
and 3D printing. 

In 3D modelling, designers use software to create digital 
models of objects or environments. These models are typically 
made of polygons, which are simple shapes such as triangles, 
squares, or circles that are combined to form complex shapes. 
By manipulating these shapes, designers can create highly 
detailed and realistic models. 

3D models can be classified as either low poly or high poly. 
High poly models are those that have a high polygon count, 
meaning that they are highly detailed and contain a large 
number of polygons. These models are typically used for high-
end applications where realism is a top priority. However, 
rendering times for high poly models can be very lengthy, and 
they require powerful hardware to create and manipulate. 

Low poly models, on the other hand, have simplified 
polygons, meaning that they have less detail than high poly 
models. They are easier to load, view, and edit, and they can 
be worked on faster with minimal lag. Low poly models are 
typically used for applications such as mobile games, where 
performance is a top priority. 
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3D Modelling Softwares 

• Maya: A licensed software mainly for animation, motion 
graphics, virtual reality, and character creation. 

• Cinema 4D: A licensed software specialising in 3D 
modelling, animation, and rendering software. Cinema 4D 
is often used in the film and broadcast industries for its 
integration with Adobe After Effects and other software. 

• 3DS Max: A licensed software for modelling, architecture, 
engineering, and construction development. It has a wide 
range of modelling and texturing tools, as well as tools for 
animation, simulation, and rendering 

• Blender: A free open source software primarily used for 
animation and visual effects 

• Sketchup: A popular licensed software for architects, 
interior designers, and engineers because of its ease of use 
and quick modelling capabilities. Sketchup’s 3D 
Warehouse allows users to access a library of free 3D 
models 

• Rhinoceros 3D: A licensed software for creating 3D models, 
rendering, and fabrication. Rhino supports NURBs (Non-
Uniform Rational B-Splines) geometry modelling. Rhino’s 
Grasshopper plugin allows users to create complex 
algorithmic designs using visual programming 

Game Engines 

Game engines are game development softwares used to 
create 3D and 2D interactive games. They are used to make 
virtually every video game that is currently available, and can 
be used to develop 2D side scrollers, 3D First Person games, or 
VR simulations. 

Two of the most popular game engines that are open source 
are Unity and Unreal, both of which will be showcased in this 
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guide. Although both Unity and Unreal function in similar ways 
and can both be used to create similar end products, there are 
slight differences between them that make them unique. 

Unity Vs. Unreal 

Unity is known for its user-friendly interface and fast 
development process, making it a popular choice for indie 
developers and small studios. It also supports a wide range of 
platforms, including mobile devices, consoles, and PC. 

Unreal Engine, on the other hand, is known for its powerful 
graphics capabilities and advanced features, making it a top 
choice for AAA game development. It also has a strong 
community and support for creating immersive experiences in 
virtual reality. 

Below is a chart that shows the differences between the two 
game engines, and will help you understand which would be 
the best game engine to use for your content. 

Source: https://hackr.io/blog/unity-vs-unreal-engine 
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BLENDER 

Why Blender? 

Blender is a popular free to download, cross- platform 
compatible and open-source 3D modelling, animation, and 
rendering software application used by many artists, designers, 
architects, and game developers. It can allow users to create 
complex 3D models, animations, and visual effects, and it 
supports a wide range of features, including 3D modelling, UV 
unwrapping, texturing, rigging, animation, simulation, 
rendering, compositing, and motion tracking. 

Blender is known for its user-friendly interface, powerful 
tools, and flexible workflow. It also supports various file formats, 
including 3D models, textures, animations, and videos, making 
it a versatile tool for 3D modelling and animation projects. 
Additionally, it has an active and supportive community that 
provides helpful tutorials, add-ons, and resources to users. 

• For beginners – user-friendly 
• Open source software 
• Free to download 
• Easily accessible 
• For 3D modelling and animation 
• Cross platform compatible (Windows, Mac OS, or Linux) 

Blender and Rhino 3D are both popular 3D modelling software 
with their unique strengths and limitations. Blender is a free 
and open-source software primarily used for animation and 
visual effects. It has a steep learning curve but offers a vast 
range of modelling tools and a highly customizable interface. 
On the other hand, Rhino 3D is a licensed software designed 
primarily for NURBs (Non-Uniform Rational B-Splines) 
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geometry modelling. Rhino 3D can be highly precise. Rhino 3D 
also allows users to create complex organic shapes with ease 
and is well-suited for 3D printing and prototyping. 
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Blender Tips 

Hardware Requirements 

Minimum 

• 64-bit quad core CPU with SSE2 support 
• 8 GB RAM 
• Full HD display 
• Mouse, trackpad or pen+tablet 
• Graphics card with 2 GB RAM, OpenGL 4.3 
• Less than 10 year old 

Recommended 

• 64-bit eight core CPU 
• 32 GB RAM 
• 2560×1440 display 
• Three button mouse or pen+tablet 
• Graphics card with 8 GB RAM 

*Tip! Use a 3-button mouse to make your Blender navigation 
easier 

Source: https://www.blender.org/download/requirements/ 

File Types, Which Ones Should I Use? 

What file type to use? 
Blender offers a wide range of different file formats for 

importing and exporting. The versatile file formats allow you 
to store various data types depending on your project. For use 
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with the Immersion studio, 3D assets are imported into Unity/
Unreal. 

When creating your 3D projects ensure to always save your 
work and export your model with the compatible file type for 
unity/unreal. We have constructed a simple table that lists the 
most used file formats that are currently associated with or are 
compatible with Blender 3D and Unity/Unreal Engine. 
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File 
Type 

Compatible 
with Unity/
Unreal 
Engine 

Description 

.blend N 

Native file format used by Blender. These 
files contain all the information needed to 
create and edit 3D models, such as mesh 
data, texture information, animation 
keyframes, lighting, and camera settings. 
Blend files can only be opened and edited 
within Blender. However, Blender can 
export models to various formats such as 
FBX, OBJ, and Collada, which can be opened 
in other 3D software or game engines. 

.fbx Y 

FBX is developed by Autodesk3D file 
formats used for exporting and importing 
3D models across different software 
programs and is widely supported. FBX files 
are best texture preservation and 3D data 
conversion between softwares. They also 
support animation for 3D models. 

.obj Y 

A standard 3D file format used for exporting 
and importing 3D models across different 
software programs and is widely supported. 
Obj files are the most compatible 3D file 
across most softwares but do not support 
animation. 

.glb/.gltf Y 

GL Transmission Format (glTF) is an 
open-source and royalty-free 3D file that 
supports static models, animation, and 
moving scenes. glTF is used in games, native 
web applications, AR, VR, and 3D ads. It is 
designed to be compact and efficient for 
use on the web. 

.usdz N 

USDZ is developed by Apple and is 
optimized for use on iOS devices, designed 
specifically for web and AR applications and 
may have limited compatibility outside of 
web and AR applications. The USDZ format 
is only compatible with iOS platforms. 

.stl Y 

3D file format used for 3D printing. It is a 
surface-based format that defines the 
geometry of a 3D object using triangular 
facets. 
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Blender, How to Get 
Started 

How to Get Started? 

When it comes to creating in Blender, it’s important to keep 
several things in mind. First and foremost, you need to 
approach your work from a three-dimensional perspective, as 
Blender is a 3D modelling software. This means considering 
factors such as camera angles, lighting, materials, and gravity. 

To get started with 3D modelling in Blender, it’s helpful to 
have a basic understanding of the software’s interface and 
navigation tools.  There are many existing helpful tutorials, here 
are a few popular “Blender Basics for Beginners” conveniently 
found here (Please take note of the Blender version when 
watching these tutorials). 

However, if you’re new to Blender and want to get started 
with 3D modelling, there are a few steps you can follow: 

1. Download and install Blender: Blender is a free and open-
source software available for download from the official 
website. 

2. Familiarize yourself with the interface: Blender’s interface 
can be overwhelming at first, but there are many tutorials 
and resources available online to help you get started. 

3. Start with basic shapes: Blender allows you to create basic 
shapes like cubes, cylinders, and spheres, which you can 
use to create more complex models. 

4. Learn the modelling tools: Blender has a wide range of 
modelling tools, including extrude, bevel, and boolean, 
which you can use to modify and shape your objects. 

5. Practice and experiment: 3D modelling takes time and 
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practice, so don’t be afraid to experiment and try new 
things. There are also many online communities and 
forums where you can get feedback and support from 
other Blender users. 

Additional Blender Resources: 

Blender Download: https://www.blender.org/ 
Blender Basics: https://youtu.be/6FaLHFJ2kKI 
Blender Tutorial 1: https://www.youtube.com/

watch?v=UXqq0ZvbOnk 
Blender Tutorial 2: https://www.youtube.com/

watch?v=X4MXWcx4jUA 
CGCookie: https://cgcookie.com/lessons/welcome-to-the-

blender-basics 
Blender.org tutorials: https://www.blender.org/support/

tutorials/ 
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Blender HotKeys that 
Might be Helpful? 

When working in 3D modelling software, having a 3 button 
mouse is highly recommended. While creating 3D models, 
using shortcuts make your modelling process just a bit faster. 

Below is a list of Common Blender shortcuts 
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For a more in depth list of HotKeys, visit the Blender Hotkey 

Reference PDF, https://download.blender.org/documentation/
BlenderHotkeyReference.pdf 

 

Navigation: 

• Hold the middle mouse button to navigate 
• Hold shift+ middle mouse button: Pan 

Shortcut: 

• Edit-> Preferences: To create new shortcuts 
• F3: Search Bar-> Change that into space for easier use 
• G: Move-  G+Z: Move in Z direction, G+Y: Move in Y 

direction, G+X: Move in X direction 
• R: Rotate- R+Z: Rotate in Z direction, R+Y: Rotate in Y 

direction, R+X: Rotate in X direction 
• S: Scale- S+Z: Scale in Z direction, S+Y: Scale in Y direction, 

S+X: Scale in X direction 
• (G, R, S) + Shift+(X,Y,Z): To exclude that direction 
• Alt+G: put the object in the center 
• Shif+A: Adding objects to your scene, you can use the 

search bar instead 
• Shift+D: Duplicating objects 
• 0: Camera View, 1: Front View, 7: Top View 
• /: Isolating an object (Local View) 
• Shift+S-> Cursor to Selection 
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Modelling: 

• Search bar-> Add a Cylinder, Add Camera, (Change the 
vertices if you need before doing anything else!) 

• Transform Tab: change the dimensions. 
• Edit Mode (Top left): To edit the objects (Vertex, Edge, 

Surface) 
• P: Select the face, Vertices, or edges you want and 

separate them from your model 
• Ctrl +R: Add Edge Loop 
• E: Extrude 
• S: Scale 
• F: Close the Gap 
• X: Delete 
• Alt+Click: select all 
• Modifier Properties(In the right Menu): Add a Modifier 

1- Solidify: To give a bit of shell to a surface, Check Even 
Thickness—>Apply Scale after! 

2-Boolean 
3-Bevel 
4-Subdivision 
5-Smooth/ Shade Smooth 

◦ Remember to apply your modifiers after editing 

6- Screw 
7-Array 

• To hide an object: Obj Properties (In the right menu)-> 
Uncheck Render and Viewport display 
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Material: 

• Material Tab(In the right menu)-> Create a new material-> 
Change the base color to grey, reduce the specular 0.16, 
and increase the roughness. 

• Ctrl + L: to assign your material or create a link between 
your selected objects and the material 
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Blender Modelling 
Tutorial 

Blender’s 3D modelling features allow users to create a wide 
range of objects, from simple geometric shapes to complex 
models with intricate details. We will go through a brief tutorial 
on 3D modelling. 

To create a basic lamp, we can start by using basic geometric 
shapes such as cylinders to create the lamp’s body and shade. 
You can then add textures and colours to create a more realistic 
look. Once completed, the lamp can be saved as a .blend file, 
which includes all the meshes, textures, and materials used to 
create it. The finished model can then be imported into game 
engines like Unity or Unreal and used in 3D projects by adding 
lights and adjusting its scale to fit the scene. 

 
1. First, download Blender and start up a “New File” > General 
2. Add a cylinder, by pressing Shift + A (AddMenu) 

3. Select the newly added cylinder by left clicking, LMB 
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4. Extrude selected Cylinder by pressing E, and scale by the 
Z-axis, by pressing Z immediately after 

4a. Extruding without Z-axis, will scale all sides of the model 
equally 

5. Toggle Edit Mode by pressing Tab to edit individual 
vertices, edges, and faces of the model 

6. In Edit Mode, create a loop cut by pressing Ctrl + R and 
using your middle scroll wheel to scroll how many cuts you 
want to create in your model 

7. Ensure that you have selected vertices as your selection 
mode, to select all vertices in one line press  Shift + Alt + LMB 

8. Scale the selected row to create a tapered base 
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9. Continue step 7 and 8 for the corresponding lines to create 
a unique lamp body shape 

10. Add a new cylinder model for the Lamp shade, Shift + A 
(AddMenu) 

11. Scale the lamp shade to size, Move the new cylinder to the 
top of the lamp body by pressing G then Z to move along the z 
axis 

12. Select all vertices in one line press  Shift + Alt + LMB, 
scale down the top lamp shade to create a tapered lamp shade 
shape 

13. Select faces of the top and bottom of the cylinder, press x 
to delete the two faces 
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14. Once happy with the shape of your lamp, select the lamp 
body and go to Object> Shade Smooth to smoothen all the 
edges of the model 

15. Add textures to your model, Open the material editor, 
shaped as a red circle 

16. Add a NEW material on your selected object. In this case 
the lamp body.  Create a new Image Texture 

17. You will be prompted to import a file, select your jpg/png 
file as your texture image 

18. Select UV Editing, to start editing the texture you apply to 
your mesh model. 

19. Ensure you are in Edit mode, select a face on the body of 
the lamp. Press A to select all faces of the body lamp. 
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20. Once all faces are selected, Press S to scale the faces of the 
model in order for the scaling of the texture to look accurate 

21. Repeat step 21, for the lamp shade, and your lamp shade 
texture of your choice 

22. Move your lamp object to the origin by selecting the 
bottom face 

23. With the face still selected, Press Shift + S, then select 
“Cursor to Selected” 

24. Next, Go to the “Object” dropdown menu and select “Set 
Origin” > Origin to 3D Cursor 
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25. To scale your object, first parent the object, to group your 
separate objects together 

26. Then scale your object 1:1 by pressing S, to the desired size 
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TMU LIBRARY 
IMMERSION STUDIO 
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Immersion Studio 
Overview 

The Immersion Studio is a resource located in the TMU Library 
for faculty and students to create research and teaching 
projects using collaborative virtual reality (VR) experiences and 
immersive media. The space is a full 360° projection cylinder 
that is 6 meters in diameter and 2.3 meters tall that utilizes 5 
ceiling mounted projectors to stitch images together to create 
a seamless 360 image. Because the Immersion Studio is an 
open space that does not require the use of any peripherals 
or headgear to interact with the content, it is an attractive 
alternative for faculty and students wishing to create and 
experience 360° and VR content. The Immersion Studio can 
accommodate people who are either standing or seated, and 
can accommodate up to 10 people. 

 
The Immersion Studio is designed for students and faculty 

looking to explore new forms of collaborative, immersive 
experiences whether that be simulations, visualizations or 
immersive exhibitions. Although traditional VR headsets may 
be considered more accessible due to headset availability, the 
Immersion Studio enables collaborative, immersive, and 
shared VR applications that can be experienced by multiple 
people at the same time. Certain drawbacks of traditional VR 
headsets include an isolating individual experience, eye strain 
from HMD lenses, and frequent cleaning for safe use between 
multiple people. The Immersion Studio provides a more 
attractive alternative for viewing VR content in these specific 
areas, making it a more viable solution for research projects 
related to collaborative/ shared VR, 360° media, or immersive 
installations. 
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The most common forms of content creation for the 

Immersion Studio are 360 images, 360 video/audio, and 3D 
applications developed in Unity or Unreal. Below are the 
optimum file requirements for each type of media. 

• 360 Photos: 8000px x 1000px (Jpeg or PNG)360 
• Video: 4k (3840 × 2160) 360° Video (Either as Mp4 or 

Youtube link) 
• VR/3D Content: Packaged Unity OR Unreal Projects 

For more information on the Immersion Studio, you can visit 
the TMU Library website here: https://library.torontomu.ca/
services/facilities/immersion/ 

Immersion Studio Hardware Specifications 

Immersion Studio AV System 

Full 360° projection 

6 meters in diameter 
Wireless control via Parsec 

application 
Maximum occupancy: 15 
Image aspect ratio = 8:1 
Curved, lockable door to 

complete 360º fabric screen 
Dartex blackout cap with 

integrated HVAC ducts for 
AC Unit 

5 x full HD (1920 X 1080) 3500 lumen 
ceiling mounted projectors 

7.1 surround sound speaker system 
with 5 JBL speakers and 1 subwoofer 

Windows 10 PC media server with 
2 NVIDIA Quadro RTX-5000 Graphics 
Cards 

Apple iPad (8th Generation) for 
wireless control of 360 images and 
video 

2 HTC Vive Base Stations (1.0) + 2 
Vive Controllers & Steam Controller 
for VR and motion controls 

Microsoft Kinect V2 for hand and 
body tracking 
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Immersion Studio Layout 
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VR PROJECTS 
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VR Projects In Unity 

The Unity Game Engine developed by Unity Technologies and 
can be used to create 2D and 3D interactive games. Unity uses 
the C# scripting language to handle interactions, and has one 
of the largest communities of developers in the 3D 
development industry. This is especially the case with indie 
game studios and mobile app developers. In addition to 
creating 2D and 3D games, Unity can also be used to create VR 
games and VR experiences, which is what we will be focusing 
on specifically 

A VR project can be created in a number of different ways 
in Unity, but in order for the project to work in the Immersion 
Studio, it will need to have the SteamVR plugin installed and 
enabled. Please note that Open XR is currently not supported 
in the Immersion Studio as of March 2023. 

Resources 

Unity Game Engine: https://unity.com/ 
SteamVR Unity Documentation: 

https://valvesoftware.github.io/steamvr_unity_plugin 
SteamVR Plugin: https://assetstore.unity.com/packages/

tools/integration/steamvr-plugin-32647 
Unity VR Development Tutorial: https://youtu.be/

gGYtahQjmWQ 
Immersion Studio Unity VR Template Project: 

https://drive.google.com/file/d/1H8-BP1_HjHWcj2r-
cywCS76TNcDG3bj6/view 
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Working With The 
Unity VR Template 
Project 

The Unity VR Template project can be downloaded in the 
resources link provided, and has everything you need to get 
started working with VR projects in Unity. The project contains 
the assets from the blender tutorial, along with additional 
royalty free 3D models. It also contains the necessary plugins 
to run VR interactions for SteamVR, and the required plugins to 
make the project compatible with the Immersion Studio. You 
can either work with the assets available in the assets folder, 
or you can upload your own assets by dragging them into 
the open Unity project. There are two important interactions 
needed in order to achieve an engaging VR experience. These 
two interactions will be outlined below. 

VR Navigation & Interactions 

In order to navigate through a 3D scene, you will need to have 
some form of navigation that enables locomotion. In traditional 
VR and in the Immersion Studio, it is important to note that 
traditional omnidirectional movement using the arrow keys 
and mouse is not the ideal way of locomotion. This is because 
omnidirectional movement has a tendency to cause motion 
sickness in most forms of VR. Instead, the main navigation 
system in VR through teleportation, as in pointing the VR 
controller in a direction and warping to that location in VR. The 
result looks like the screenshot below. 
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By default the template VR Unity project that is provided will 

have VR navigation and interactions already enabled. You can 
place your 3D object onto the navigation floor of the 3D scene 
to enable navigation for your own project without the need to 
add additional movement components to your scene. If you 
are importing a separate project and you want to enable VR 
navigation and interaction, you can follow the steps below to 
do so. 

 

VR Navigation 

1. Select the 3D object in your scene that you would like to 
enable as an object used for navigation (ex. floor) 
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2. Duplicate that object by copying and pasting it in the 
same location 

3. Select the cloned object from step 2 and in your inspector 
panel, click on the “Add Component” button\ 

4. Search for the “Box Collider” component and add it to your 
object 

5. Next, search for the “Teleport Area” script and add the 
script to your object 

6. The object should not have teleport navigation enabled. If 
done correctly, the inspector panel for your object should 
look similar to the inspector panel on the right in the 
image below. 

 

 

VR Grab Interaction 

1. Select the object you want to be interacted with 
2. In the inspector panel, click the “Add Component” button 
3. Add the Rigidbody component 
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4. Once the Rigidbody component is added, check the “Use 
Gravity” box 

5. Next, add the Box Collider component 
6. After the Rigidbody component and the Box Collider 

component have been added, you can add the 
“Interactable” script and the “Throwable” script to the 
object 

7. If done correctly, the object should now be grabbable and 
throwable in your scene. The inspector panel for your 
object should look similar to the inspector panel on the 
right in the image below. 

 

Immersion Studio Unity Plugin 

In order for a Unity project to work in the Immersion Studio, we 
need to import the IglooUnityToolkit asset package on the TMU 
Library website found in the link above. When the package is 
imported to an existing project and the IglooManager prefab 
has been added to an open scene, the project should be 
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compatible with Unity via the Igloo Warper program. Please 
also note that The Unity plugin was tested and working for 
Unity 2020.3.0f1 and below. It is not guaranteed that this plugin 
will work for versions of Unity beyond the year of 2020. 

Resources: 

Unity Igloo Plugin Documentation: 
https://360igloo.atlassian.net/wiki/spaces/IG/overview 

Immersion Studio Resources: https://library.torontomu.ca/
services/facilities/immersion/resources/ 

 
The steps to importing and setting up a unity project are as 

follows: 

1. Download the Unity Plugin from the Immersion Studio 
Resources link above 

2. In your open Unity project, click on Assets in the 
navigation bar at the top 

3. Hover over Import Package and select Custom Package 
4. Find the Unity Plugin folder that was downloaded in step 1 

and select IglooUnityToolkit-Dev-v1.2.1-1.unitypackage 
5. Select “Import” from the pop up window in Unity 
6. In the project window in the Unity editor, you should now 

see a folder called “IglooTools” 
7. In the IglooTools folder, find the IglooManager prefab by 

navigating to Resources – Prefabs 
8. Drag the IglooManager prefab into your open Unity scene 
9. Your project should now be compatible with the 

Immersion Studio 
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Running Unity In The Immersion Studio 

1. Open your Unity project 
2. Once the Unity scene is running, open the Igloo Warper UI 

window and select Layers – External Application Inputs, then 
check the Igloo Unity box and make sure it is Enabled. Your 
Warper UI window should look like the image below 

 
3. The Unity scene should now be running in the Immersion 

Studio, and you can navigate around the 3D scene by holding 
up on the circular touchpad on either controller 

Troubleshooting In Unity 

• If the Unity scene does not display in the Immersion 
Studio after following the above instructions, close the 
Igloo Warper app and repeat steps 4 – 5 

◦ The Igloo Warper app has a known issue where the 
inputs of the projectors will not properly refresh when 
going between Unity and Unreal. As a result, you may 
see the last visual of Unreal if it was previously open, or 
vice versa if Unity was previously open before Unreal. 

• If the VR controllers are on but not displaying in the 
Immersion Studio 

◦ Double check that SteamVR is open and running 
◦ Make sure the green light is on for both controllers 
◦ If the above statements are true, restart the SteamVR 

app and play the Unity Scene again. If necessary, close 
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Unity and restart the application 
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VR Projects In Unreal 

The Unreal Engine was developed by Epic Games and acts in 
a similar fashion to Unity, but relies more on a visual scripting 
language called Blueprints. Instead of using C# scripts found 
in Unity, Unreal uses its node based blueprint visual scripting 
system to create interactions. It is also important to note that 
the blueprint coding system in Unreal is based off of a C++ 
scripting language. This is important in case you decide to 
use custom scripts that are not available in the existing Unreal 
packages. 

The main advantage of using Unreal to Unity is the visual 
quality of the rendering engine. Unreal and Unity have very 
different rendering engines for their 3D environments, which 
is especially notable with lighting. In almost all cases, Unreal 
tends to look better in terms of visual aesthetics compared to 
what you would see in Unity. 

Resources: 

Unreal Game Engine: https://www.unrealengine.com/en-US/ 
Unreal SteamVR Documentation: 

https://docs.unrealengine.com/4.26/en-US/
SharingAndReleasing/XRDevelopment/VR/SteamVR/ 

Unreal VR Development Tutorial: https://youtu.be/
DiGh6MxDFds 

Immersion Studio Unreal VR Temple Project: 
https://drive.google.com/file/d/

1Kp3oGRn9yFkhYCrPCFKa7RdWqQz9mB5m/view 

Working With The Unreal VR Template 
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Project 

The Unreal VR template project can be downloaded from the 
resources link, and contains everything you need to create a 
VR experience for either a VR headset or for the Immersion 
Studio. More specifically it contains 3D royalty free assets, an 
interactable 3D environment, and the plugins required for 
SteamVR interactions and for the Immersion Studio. You can 
use the resources provided in the project folder as you wish, 
and add your own assets to the template project. It should be 
noted that if a VR project was created in Unreal using the Open 
XR plugin or Oculus plugins, these will need to be disabled 
in order to use the VR controllers that are compatible for the 
Immersion Studio. 

VR Navigation & Interactions 

Similar to the navigation in Unity, locomotion will be handled 
through teleportation instead of omnidirectional arrow key 
movement. The teleportation works exactly the same way as it 
does in Unreal to how it works in Unity, with only slight visual 
differences. However, there are different ways of setting up the 
navigation in Unreal as opposed to Unity, which we will go into. 
The steps below will allow navigation and interaction with your 
own Unreal project by focusing on two main components that 
can be applied to your 3D objects. 

If you are starting with your own Unreal project, you will need 
to follow the steps below to allow VR navigation. Please note 
that the VR controllers will not work if the proper plugin is not 
enabled. The Immersion Studio always uses SteamVR for VR 
interaction, so this plugin must always be enabled, with every 
other XR plugin (such as Open XR) be disabled. 

42  |  VR Projects In Unreal



VR Navigation 

1. In your open Unreal project, make sure the “Place Actors” 
panel is open by enabling in the Window tab at the top of 
the editor 

2. Once your place actors panel is open, find the “Nav Mesh 
Bounds Volume” using the search bar 

3. Drag the Nav Mesh Bounds Volume into your open map. 
You will notice the object appears as a box outline. 
Anything within this box will be enabled for navigation. 

4. After the component has been added to your map, you 
can enlarge and move the Nav Mesh Bounds Volume to fit 
the size of your 3D environment. 

5. Your map should be enabled for VR controllers navigation, 
which can be tested by using the VR Preview play button 
at the top of the editor. If done correctly your map will look 
similar to the image below, and have the 
NavMeshBoundsVolume component in the World 
Outliner panel on the right side. 
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VR Grab Interaction 

1. In the Place Actors panel, click and drag in an empty actor 
into your map 

2. With the empty actor selected, click on the blueprints 
button at the top as seen in the image below 

3. Click “Convert Selection To Blueprint Class” 
4. In the popup window, search for the 

“Grabbable_SmallCube” and click select 
5. Next, navigate to the Details panel and change your static 

mesh and your material to the new object you would like to be 
interactable. 
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6. Click the compile button at the top of the window as seen in 
the image below 

7. Your object should now be grabbable. You can test this by 
clicking VR Preview in the drop down of the play button see in 
the image below 
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Immersion Studio 
Unreal 4 Plugin 

Similar to the Unity plugin, the Unreal plugin needs to be 
downloaded from the TMU Library resources page in the link 
above. Please note that before following the steps below, you 
must first quit any open Unreal projects or applications, 
otherwise the Igloo plugin will not work. Please also note that 
the Unreal plugin has been tested and working for Unreal 4.27. 
There are no guarantees it will work for versions beyond 4.27. 

Resources: 

Unreal 4.27 Igloo Plugin Documentation: 
https://360igloo.atlassian.net/wiki/spaces/IGLOOTOOLS/pages/
28147732/First+Time+Setup 

Immersion Studio Resources: https://library.torontomu.ca/
services/facilities/immersion/resources 

After closing down your Unreal project, follow the steps 
below: 

1. Navigate to the root directory of your project folder. Your 
folder structure should look similar to the screenshot below. 
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2. Create a new folder in this directory called “Plugins” if the 
folder is not already created. 

3. From the Unreal zip file that was downloaded from the 
TMU Library resources, open the “Plugins” folder, which can be 
found in the Igloo Unreal 4.27_Plugin folder 

4. In this folder you will find three more folders (Igloo, 
IglooOSC, and IglooSpout) 

5. Copy those folders and paste them into the Plugins folder 
you created in your Unreal project directory from step 2 

6. After the folders have been pasted, open the content folder 
in your Unreal project directory 

7. Next, open the content folder in the Unreal plugin folder 
(you should find a single folder labelled “Igloo”) 

8. Copy that Igloo folder and paste that folder into the 
content folder within your Unreal project folder 

9. Launch your Unreal project and find the Igloo360 Camera 
Rig actor in the Igloo folder within your Content Browser 

10. Drag the Igloo360 Camera Rig into your open map 
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11. Your project will now be setup to run in the Immersion 
Studio 
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Immersion Studio 
Unreal 5 Plugin 

First download the Unreal 5 plugin zip file from the Immersion 
Studio resources link below. 

 
Immersion Studio Resources: https://library.torontomu.ca/

services/facilities/immersion/resources/ 
Note: Before installing the Unreal 5 plugin, you must first 

make sure that your Unreal 5 project has a .sln file in its 
directory such as in the screenshot below. 

 

 
If your project does not have a .sln file in the project directory, 

you need to create one first before installing the Igloo plugin. 
To do that, please follow the instructions found in the Igloo 
documentation below. 

Unreal 5 Igloo Plugin Documentation: 
https://360igloo.atlassian.net/wiki/spaces/IGLOOTOOLS/

pages/3233087489/Installing+the+Igloo+Camera+System 
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After you have created a .sln file for your Unreal 5 project, you 

can install the Igloo plugin by following the steps below: 

1. In your project directory, create a folder called “Plugins” if 
the folder is not there already 

2. Next, copy and paste the IglooUnrealToolkit from the 
downloaded zip file into the Plugins folder in your project 
directory 

3. Start your Unreal project 
4. In the top right corner of the Unreal editor, click “Settings” 

then click “Plugins” 
5. Make sure the Igloo Unreal Toolkit plugin is installed and is 

enabled. You should see a similar window to the 
screenshot below. 

6. 
Close the plugins window and find the Igloo Camera Rig 
BP class located in the plugins folder within the Content 
Browser 

7. Drag the Igloo360 Camera Rig into your open map 
8. Your project will now be setup to run in the Immersion 

Studio 

Running Unreal 4 & 5 In The Immersion 
Studio 

1. Navigate to your project and open it in Unreal 
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2. Navigate to the top of the game window and press Play 
Button 

3. After the scene plays, hit the escape key on the keyboard 
to exit the simulation 

4. Open the Warper UI application and in the navigation bar, 
select Layers – External Application Inputs and check the 
box next to Igloo Unreal to make sure it is enabled. Your 
Warper UI window should look like the image below. 

5. 
Go back to Unreal and click the Play button again to 
ensure everything is working, and the VR controller is 
tracking 

◦ Note: You will notice only one controller is currently 
enabled in the scene when you move it around the 
Immersion Studio. The other controller is disabled by 
default, and will not be shown in the Immersion 
Studio. The other controller can be left to the side 
when the demo is running 

• 
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Troubleshooting in 
Unreal 

Troubleshooting In Unreal 

• If the Unreal demo is not displaying (either because it is 
displaying a Unity scene or nothing at all), close the Igloo 
Warper app and restart it 

• If the Unreal demo is running but no controllers are 
showing up in the Immersion Studio, wait 30 seconds to 
one minute then try holding the controllers up again 

◦ ○ You should see at least one controller display in the 
Immersion Studio, but not the other. This is because of 
the way the current Longhouse demo is set up. This 
may change in the future. 

• If the same problem above persists, try restarting the 
SteamVR app 

• If the Unreal demo is running and the controller is 
displaying but you cannot navigate or interact with the 3D 
environment, you are most likely in PLAY mode in the 
Unreal editor. To fix this, stop the Unreal simulation and 
select the down arrow next to the play button and select 
VR Preview. See the image below for reference. 
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• If the above methods do not work, and the Unreal project 
is running but you cannot interact with anything in the 
scene, restart Unreal and relaunch the Longhouse project 

 
Side Notes: 
If the room setup has been reset, or if the VR controllers 

are tracking in the opposite direction in Unreal, check the 
following: 

• In the VR Pawn BP, make sure the Igloo camera manager 
is 180 degrees on the z axis 

• In the scene, make sure the player start component is 
adjusted so that the player is oriented forward from the 
start 

• Make sure the camera in the VR Pawn BP is located in the 
center to insure accurate tracking in the middle of the 
Immersion Studio 
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INTRO TO ALTERNATE 
WORKFLOWS 

The below workflows provide alternative options of going from 
various 3D softwares to Unreal 5. It is important to note that for 
any project that is intended to have interaction or is intended 
to be visualized in the Immersion Studio, it must first be 
imported to either Unreal or Unity to create a compatible link 
between the 3D scene and the Immersion Studio. Below are 
some examples of how you can use software such as Revit, 
Twin Motion, or Unity Reflect to create interactive visualisations 
with game engines. 
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Revit and Unreal 
Engine 5: 

1. To download the Datasmith plugins for various CAD 
software, such as Revit, 3Ds Max, Rhino, and SketchUp, 
follow the link provided and click on the “GET THE 
PLUGINS” button. Then, download the Autodesk Revit 
Exporter and install the file. 

https://www.unrealengine.com/en-US/datasmith 

2. Open your Revit file. You will see a new tab called 
Datasmith in your top panel. From settings, you can change 
the Level of Tesselation and Insertion point. You can bring your 
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file into Unreal using two methods: exporting your project as a 
Datasmith file or using the real-time connection. If you’re done 
editing your file, export it as a Datasmith file. However, if you’re 
still updating it, use the real-time connection instead. 

OPTION A: EXPORTING AS A DATASMITH FILE 

3. To export your file, click on the “Export to Datasmith File” 
button, create a new folder for your exported file, open it, 
and save your export in that folder. Wait for the exporting 
process to finish. 

IMPORTANT: purge your file before exporting and delete 
anything that you can add in Unreal later, such as the plants or 
furniture objects with low quality. 

4. Go to Epic Game Launcher and launch a blank Unreal 
Engine 5 project. To do this, select “Game Mode”, and then 
“Blank”. Alternatively, you open a Virtual Reality scene, 
which already has blueprints for many interactions in the 
starter content. Select blueprint, and click create. 
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5. For Unreal to read the Datasmith file, activate the plugin 
within Unreal. To do so, go to “Edit” from the top menu 
and select “Plugins”. In the search bar, search for 
“Datasmith”. A list of relevant Datasmith plugins will 
appear. Select the “Datasmith CAD Exporter” checkbox 
and click the “Restart Now” button. 
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6. Once Unreal has restarted and reopened, click on the 
“Add” button from the top dropdown menu and select 
Datasmith. From here, you can choose the “File Import” 
option. Then, locate the folder you created before and 
open the exported Datasmith file. Choose the “Content” 
folder as the location for the import and in the next 
window, deselect “Lights”, “Camera”, and “Animation”, 
then click on “Import.” 
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OPTION B: USING REALTIME CONNECTION 

7. To use the realtime connection instead of importing files, 
you can use Directlink Import in Unreal. To generate the 
link, first select the connection button in Revit. Then select 
the “Direct Link Import…” from the dropdown menu to 
import your project. 
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8. If you have different projects open in both Rhino and Revit 
or different Revit files, you may see different available 
sources in the opening import pop-up window. Make sure 
to select the correct source to import the correct file into 
Unreal. 
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9. In the blank Unreal project, there is already a landscape 

layer. To clean and organize your scene, you can hide or delete 
the layer from the right window. 
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Rhino and Unreal 
Engine 5: 

1. Download the Datasmith plugins for various CAD software 
including Rhino, Revit, 3Ds Max, and SketchUp using this 
link: https://www.unrealengine.com/en-US/datasmith. 
Click the “GET THE PLUGINS” button, and then download 
and install the Rhino Exporter.

   

2. Open your Rhino file and find the new menu called 
Datasmith. You can bring your file into Unreal using two 
methods: exporting your project as a Datasmith file or 
using the real-time connection. If you’re done editing your 

64  |  Rhino and Unreal Engine 5:



file, export it as a Datasmith file. However, if you’re still 
updating it, use the real-time connection instead. 

OPTION A: EXPORTING AS A DATASMITH FILE 
3. To export your file, use the Export3D view option. Then 

open Unreal Engine 5 and create a new blank project in “Game 
Mode”. First, install the Datasmith plugins by selecting 
“Plugins” under the “Edit” tab on the top menu, searching for 
“Datasmith”, and selecting the “Datasmith importer”. Then 
restart Unreal and wait for it to reopen. 
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4. In Unreal, click the “Quick Add” button and select 
“Datasmith” and “File Import”. Find your exported file and open 
it. In the “DataSmith Import Option” window, choose the 
options you want to import, such as “Materials & Textures” and 
“Geometry”, for a Rhino file. Then import and wait for your 
project to open in Unreal. 
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OPTION B: USING REAL TIME CONNECTION 
Alternatively, to preview changes to your Rhino scene in 

Unreal Engine 5 in real-time, use a Datasmith DirectLink. 
This way, you don’t need to manually re-import the entire 

scene into UE5 every time you want to make a change. First, 
ensure that you have installed Unreal Engine version 5.0.3, as 
the Datasmith Exporter does not work on previous versions. 

Next, go to Edit > Plugins in Unreal and search for 
“Datasmith” in the Search bar. Select both “Datasmith 
Importer” and “Datasmith Runtime Beta”, then restart and 
open Unreal. 

Now, in Rhino, toggle Auto Sync and in the command 
window, you will see the command: “Direct Link Auto Sync” 
enabled. Then “Synchronize”. And then click the “connections” 
button. Go to your Unreal file, from the “Quick Add” button 
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drop down menu, select “Datasmith”, and then “Direct Link 
Import.” 
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Now you can select your file from the list and import your file 
directly from Rhino into UE5. Similar to the previous method, 
specify the location and the options you want to import such 
as Geometry and Material. 
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Rhino/Revit and 
Twinmotion Workflow: 

Twinmotion is a powerful software for creating high-quality 
visualizations for various industries, such as architecture, 
consumer products, and transportation. You can update the 
model in real-time without any loss of detail and add materials, 
high-resolution assets, and lighting to your scene. It works well 
with Unreal Engine, as both softwares belong to Epic Games. 
You can also export and share your project and create 360 
videos and animations for presentation in the Immersion 
Studio. Additionally, you can use VR mode to navigate through 
your scene. However to use Immersion Studio for the VR 
experience you need to simply transfer your model from 
Twinmotion to UE. 

 
More detail about the Revit-Twinmotion Workflow 
https://www.youtube.com/

watch?v=fjBEUkYWUuc&ab_channel=Twinmotion 
Learn more about Twinmotion: 
https://www.twinmotion.com/en-US/learning-resources 
 

1. Download Twinmotion from 
https://www.twinmotion.com/en-US and create an Epic 
Games account or log in if you already have one. The free 
trial version works fine. Then, download and install the 
software. 
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2. Download the plugins. From the Twinmotion page you can 

find the section for plugins and download the desired plugins 
depending on which software you want to work with. For now 
we focus on Rhino and Revit. Download and install the plugins 
based on your operating system. 

https://www.twinmotion.com/en-US/plugins 
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3. Launch Epic Games launcher and select Unreal Engine 

from the vertical list on the left. You can then find Twinmotion 
on the top menu. If you haven’t installed Twinmotion, click 
Install and launch the software. 

Bringing your assets from Rhino or Revit into Twinmotion is 
straightforward. Twinmotion supports various formats, 
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• FBX 
• Sketchup 
• Obj 
• Cinema4D 
• Other CAD formats such as 3ds, dae, dxf, iv, stl, and more 

We are able to use direct links from various software such as 
Rhino, Revit, ArchiCAD, Sketchup, and more. Further 
information can be found on the Twinmotion webpage. 

 
4. In both Revit and Rhino, you should first “Toggle Auto 

Sync.” In the command window, “Direct Link Auto Sync” should 
now appear and be enabled. Then “Synchronize”. And then 
click the “connections” button. Alternatively, in Rhino, you may 
simply type “Datasmith DirectLink Sync” in the command bar 
and your scene will be exported. 

5. Launch Twinmotion, and from the “Import” button, select 
“Direct Link.” 
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6. In the “Direct Link settings source” you can choose your 
source software, choose your source software (Revit or Rhino) 
and import. 
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Twinmotion Unreal 
Workflow 

If you need to still add interactions to your project or you want 
to create an immersive experience using Oculus Quest or the 
Immersion studio, it is recommended to use Unreal Engine. 
Although Twinmotion has VR option which can be used with 
Oculus Quest, it is not as smooth as UE. For using the Immersin 
Studio, you definitely need UE. 

 

1. To bring your assets from Twinmotion into Unreal and to 
create a VR experience, open UE from Epic games 
launcher. 

Then select the game mode, Virtual Reality. The reason that we 
use Game mode and not the Architecture mode is that most of 
the interactions and blueprints already exist in this mode. 

You can also define your projects name and file location at 
this step. 
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2. Once you open Unreal, you will see the following scene. It 
is a good practice not to create your scene in the VR 
template folder and create your own folder called Maps 
and then create your Levels within that folder. The word 
Levels here refer to the Game Levels and not the height or 
floors as commonly used in Architecture.  Pay attention to 
create your folder within Content folder. Then create 
another folder called Level-Mesh. This folder will contain 
the mesh geometry you will import later to your project. 
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3. To bring your scene from Twinmotion into unreal you 
need to install the Datasmith plugins. To do so open the 
Epic game luncher. Tab on the Marketplace and search for 
“twinmotion”. Install both of the following plugins to your 
engine. Make sure to choose the correct engine version. 

4. Open Unreal. Go to edit, plugins and search for 
twinmotion. Make sure to check on both Datasmith 
Twinmotion Importer and Twinmotion Content and then 
restart. 

5. Save your Twinmotion file and close it. Once the Unreal 
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opens, go to your level by double clicking. Then from the 
Quick add button, go to datasmith tab, import file, and 
find your datasmith file. Choose the Level-Mesh folder to 
import your file in that folder. 
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6. Select the following options. You can change these 
options based on your projects. 
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Revit, Unity Reflect 
Review 

Unity Reflect enables designers, architects, and engineers in 
the AEC industry to easily create immersive real-time 3D 
experiences in a collaborative way. 

 
You can use Unity Reflect Review to transfer BIM/CAD to real 

time 3d and it has plugins for Revit, Navisworks, Rhino, and 
SketchUp. Also you can use local and/or cloud-hosted servers 
for data federation of multiple BIM/CAD models 

You can find the link here: 
https://store.unity.com/configure-plan/unity-reflect-review-

trial?free_trial_product=true&check_logged_in=1 

After installing the Unity Reflet Review, open your revit file. It 
will ask you to load the related plugins. Choose Always Load. 
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After opening your file, you can see a new tab called Unity 
Reflect in your top menu. 

You can either export or use the direct link. To export your file 
push the export button. Choose whether you want to use the 
Reflect oon your system or a shared Netork or Cloud. For now 
the Cloud option is not available. Then define a new project. 
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Once you created your file, open Unity Reflect and select the 
file you have created.  Your file is ready to use. 
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